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ASCENDER - Position Management: Salary
Simulations Overview

Use the following pages to set up and perform various Position Management salary simulations.
The forecast salary simulation functionality is similar to the Payroll simulations with the following
differences:

e Uses first pay date and extra duty codes versus using an extract ID parameter.
¢ Calculates fringe benefits instead of only salaries.
e Simulation amounts can be updated to Budget instead of only displaying a simulation report.

This guide assumes you are familiar with the basic features of the ASCENDER Business system and
have reviewed the ASCENDER Business Overview guide.

| Some of the images and/or examples provided in this document are for informational
£.% . purposes only and may not completely represent your LEA's process.

Position Management - Salary Simulation

Simulation Options
Create simulations. All fields must be completed.

Position Management > Utilities > Salary Simulation > Simulation Options

The Salary Simulation menu is only available when logged on to a next year pay frequency.
Create an export using Utilities > Export PMIS Tables prior to using this tab.
This tab is used to create a forecast position salary simulation and to select the parameters
associated with the simulation.

The simulation will process for positions where the school year matches the Next Year field on the
District Administration > Options > Position Management tab and where the accept changes flag is
selected for forecast records.

Each simulation will have a unique, user-assigned name and may have various salary types
included in the simulation.
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When the salary calculations are performed, the program will use the original salary amount from
the next year salary table, and then apply the percent or amount change as defined in the
associated simulation table for that salary to determine the new salary amount for that pay grade

and pay step.

Steps that have a zero

percent or amount increase are included in the salary calculations at the

rate from the original next year salary table amounts.

Salary Simulations provide budget reports without the need to overlay any employee or position

data in the NYR payroll
processed.

. Reports are available after the simulation calculations have been

If the Recalculate field is selected for a supplement position on the Maintenance > PMIS
Supplement Modify or PMIS Supplement Admin pages, and the position is not based on a regular

position, the salary tab

le amount for the extra duty is applied to the position record. If the

Recalculate field is not selected, the salary amount in the supplement position is not changed.

403B FICA Alternative contribution calculations - PMIS simulation calculations now include
403B FICA Alternative contribution calculations when the A3 deduction type is included on the

Deductions tab for the
exists for an employee

selected simulation. And, the deduction code for the A3 deduction type
included in the simulation. The reports will list the account codes and

amounts in the annuities column.

Create a simulation:

Field

Description

Simulation Name

Type the name of a simulation or click ¢ to select the simulation name
from a list.

Simulation Description|Type 3 description of the current simulation or click { to select the

simulation description from a list. The field can be a maximum of 30
characters.

O Click Retrieve. The simulation is retrieved.

Simulation Name

If retrieving an existing simulation, the simulation name is displayed. If
adding a new simulation, type the simulation name.

Simulation The description of the current simulation is displayed. If adding a new
Description simulation, type the new simulation description.
User ID This field is populated per user per simulation.

O Click Add Simulation to create a new simulation.
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L
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O Under Calculation Options:

Include Proposed
Positions

Click ™ to select Yes or No to budget for the proposed positions to
determine if they are affordable. This is a required field.

Include Vacant
Supplement Positions

Click ™ to select Yes or No to budget for the vacant supplement
positions to determine if they are affordable. This is a required field.

Note: Forecast always budgets for a vacant regular position.

Increment Pay Steps

Click ¥ to select Yes or No to increment the pay steps in the simulation.
This is a required field.

Note: If salaries will be frozen, the salary increase should be set to 0%,
and the step salary schedule should be changed by moving the amounts
from one step to another.

Maximum Annual Pay
Step

Type the two-character code for the highest pay step in your local annual
salary schedule. The field is used to identify the correct salary amount on
the salary table.

Maximum Hourly/Daily
Pay Step

Type the two-character code for the highest pay step in your hourly/daily
salary schedule. The field is used to identify the correct salary amount on
the salary table.

Increment State Steps

Click ™ to select Yes or No to increment the state steps in the
simulation. The state steps automatically max out at 20. This is a
required field.

Include TRS On-Behalf
Calculations

Click ™ to select Yes or No to include the TRS on-behalf calculations in
the simulation. This is a required field.

Expenditure Account
for TRS On-Behalf
Calculations

Type an account code to be used as an expenditure account for the TRS
on behalf calculations. The object code is always 6144 and must be
distributed by function so the function must be XX. The LEA can
determine other account code components.
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For Midpoint Salaries -
Basis of Salary Change

Click ¥ to select one of the following options:

C - Use position hrly/dly rate - Select to calculate the percentage increase
for midpoints on the actual existing rate. This option is used by LEAs that
are using a midpoint schedule in place of putting employees on a salary
schedule.

T - Use Simulation Mid Inc/Dec Amt - Select to base the percentage on
the midpoint. This option is used by LEAs that follow a midpoint schedule.
Select to calculate the percentage increase for midpoints on the actual
existing rate. This option is used by LEAs that are using a midpoint
schedule in place of putting employees on a salary schedule.

This is a required field.

For Midpoint Salaries -
Increase Pay Rate to
Minimum

Click ™ to select Yes or No to increase or not increase the pay rate to
minimum for midpoint salaries. This is a required field.

If Yes is selected, the pay rate is increased to the minimum amount if it is
below the minimum amount, and then the pay rate raise is applied per
the simulation. This ensures that employees are not paid less than the
minimum.

If No is selected, the pay rate raise is applied per the simulation, and
then the pay rate is raised to the minimum amount if it is still below the
minimum amount.

Example

Example 1:

If an employee's current pay rate is $47, the simulation is set up for a 1%
increase on midpoint, and the midpoint table amounts are set up as
follows: $50 minimum $75 midpoint $100 maximum

If Yes is selected, the pay rate is updated to $50.75, which is an increase
to $50 (the minimum) plus 1% (.75) of $75.

If No is selected, add 1% (.75) of $75 to the current pay rate of $47,
which is below the minimum so the pay rate is updated to $50.

Example 2:

If an employee's pay rate is $49.50, and all of the factors are the same as
in example 1:

If Yes is selected, the employee's new pay rate is $50.75.

If No is selected, the employee's new pay rate is $50.25.

Include TEA Health
Insurance

Click ™ to select Yes or No to include or not include TEA health insurance

in the simulation. This is a required field.

O Under Update Options:
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Simulation Descripilont' . || STAFF CURRENT RATE |3

SIMULATION OFTIONS FIRST PAY DATE CODES FUNDIFISCAL YEAR EXCLUSIONS LOCAL ANNUAL HOURLY/DAILY EXTRA DUTY MIDPOINT DEDUCTIONS UPDAT|

It updating tables, please create export for Budget Tables

Helrieve ] ’ Add Simulation ] ’ Execuls ] ’ Delate pried to using this wtility.

Simulation Mame: Simulstion Description: [ 1% ALL STAFF CURRENT RATE ] User 1D: JON
Calculation Options Update Options
nclude Proposed Positions: Update for Active Positions [' - Calculate Budget Hased on Vacancy Diata W
nclude Vacant Supplement Posiions: Yes Wt
. Update Forecast
ncrement Pay Steps: Update Budget [-,‘ - Do not update Budget v]
Maxirmum Anmual Pay Step: )
5 Update Budget Armgoasnt: [-<' - Recommended Armount V]
Maxirmum Hourly'Daily Pay Step:
Round Budget Amount to Yes W
nearest dollar:
Yes W
e [ 8- K- B 4 KKK ]
For Midpoint Salares - Basis of Salary Change (€ - Use pasition helyfdly rate ~)
For Midpoint Salames - Increase Pay Rate to
nclude TEA Health Insurance:
Update for Active Click ¥ to select one of the following options:
Positions Only A - Calculate Budget Based on Vacancy Data

B - Move Actual Amount to Budget Amount
C - Move Actual Amount to Budget if Actual > Budget
This is a required field.

Update Forecast Click ™ to select Yes or No to update or not update the forecast in the
simulation.

Only select Yes when you are ready to secure all of the positions and apply
the increase and updates to next year positions. This option moves the
simulations into the next year positions, and if selected, the pay and state
step increase is updated.

This is a required field.

Update Budget Click ™ to select one of the following options:

N - Do not update Budget

| - Increase or add to the amounts in Budget

R - Replace the amounts in Budget (This is how next year payroll to next
year budget works.)

This is a required field.

Update Budget Click ¥ to select one of the following options:
Amount R - Recommended Amount

A - Approved Amount

This is a required field.

O Click Execute to begin the simulation process.

O Under Calculation Reports:
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e Select the report(s) from the list. Click Select All or Unselect All to select all of the reports or
unselect all reports.
¢ Click Generate Reports. The reports are displayed in the order selected.

O Click Process to save the data to budget and/or PMIS records based on the Update Options
selected. You are prompted to create a backup.

Review the report.
O Click Continue to continue to the next report.

O Click Return to return to the Calculation Reports page and skip the display of the remaining
reports selected.

Duplicate a simulation:

The Duplicate From Simulation field and Duplicate button are only visible when you click Add
Simulation.

Duplicate From Simulation|Type the name of a simulation, or click ™ to select a simulation name
from a list.

O Click Duplicate to duplicate the simulation.

Delete a simulation:

O Click Delete to delete the displayed simulation.

First Pay Date Codes

Select the first pay date codes to be included in the simulation.

Position Management > Utilities > Salary Simulation > First Pay Date Codes
This tab is used to designate positions to be included in the simulation based on first pay date
codes.

You must be logged on to a next year pay frequency to access this utility.

Set up first pay date codes:
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Field Description
Simulation Name

Type the name of a simulation or click ¥ to select the simulation name
from a list.

Simulation Description|Type 3 description of the current simulation or click ¥ to select the

simulation description from a list. The field can be a maximum of 30
characters.

O Click Retrieve. The simulation is retrieved.

Simulation Name The simulation name is displayed.
Simulation Description|The description of the current simulation is displayed.

O Click First Pay Dt Cds to select a fund from the First Pay Date Codes lookup.

First Pay Date Codes

rrst Fay Date Codes :_id..'lll.h.:]

Select First Pay Date Code Date of Pay Description

[ OME 08-15- 207 Days

[ Select All ] [ Unselect ALl ] [ Ok, ] [ Cancel

O Click +Add to add a row.

Simutation Namer |3  Simulation Bescription o ) | cTarF CURRENT RATE |}

SIMULATION OFTIONS FIRST PAY DATE CODES FUNDIASCAL YEAR EXCLUSIONS LOCAL AMNUAL HOURLY/DAILY EXTRA DUTY MIDPOINT DEDUCTIONS

Samulation Name1% ALL  Deseription:1% ALL STAFF CURRENT RATE Ret ] [ rink ] [ Firet Pay Dt Cels

Delete First Pay Date Code Date of Pay

1 .-1 3 : Adg
First Pay Date Code|Type a unique pay date code. The field can be a maximum of three
characters.
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Date of Pay This field is display only and indicates the starting pay date.

O Click Save.

Fund/Fiscal Year Exclusions

Select the fund/year(s) to be excluded from the Budget update regardless of the Budget update
option. These funds are still included in the reports.

Position Management > Utilities > Salary Simulation > Fund/Fiscal Year Exclusions

This tab allows you to designate which funds should not be included in updates to budget (if
Update Budget is selected on the Position Management > Utilities > Salary Simulation >
Simulation Options tab). If no funds are selected, all funds are available for the update.

You must be logged on to a next year pay frequency to access this utility.

Create an exclusion:

Field Description

Simulation Name Type the name of a simulation or click ¥ to select the simulation name

from a list.

Simulation Description|Type a description of the current simulation or click ¥ to select the

simulation description from a list. The field can be a maximum of 30
characters.

O Click Retrieve. The simulation is retrieved.

Simulation Name The simulation name is displayed.
Simulation Description|The description of the current simulation is displayed.

O Click Budget Funds to select a fund from the Budget Funds/Fiscal Years lookup.

O Click +Add to add a row.

Fund/Fiscal Years|Type the fund code and the fiscal year. The fund code can be any digit between

101-999, and the fiscal year is a one-digit code that is the last digit in the fiscal
(school) year.

O Click Save.

2026/05/26 02:02 8 ASCENDER - Position Management: Salary Simulations Overview



https://help.ascendertx.com/test/business/doku.php/positionmanagement/utilities/salarysimulation/simulationoptions
https://help.ascendertx.com/test/business/doku.php/positionmanagement/utilities/salarysimulation/simulationoptions
https://help.ascendertx.com/test/business/lib/exe/detail.php/images/smallpicklist.gif?id=academy%3Abusiness_positionmanagement_salarysimulations
https://help.ascendertx.com/test/business/lib/exe/detail.php/images/smallpicklist.gif?id=academy%3Abusiness_positionmanagement_salarysimulations
https://help.ascendertx.com/test/business/doku.php/general/budgetfundsfiscalyears

Business

Select Fund Fiscal Year

O00ooo0ooOooooooooo

Create an exclusion:

Field Description
Simulation Name Type the name of a simulation or click ¥ to select the simulation name
from a list.

Simulation Description|Type a description of the current simulation or click  to select the
simulation description from a list. The field can be a maximum of 30
characters.

O Click Retrieve. The simulation is retrieved.

Simulation Name The simulation name is displayed.
Simulation Description|The description of the current simulation is displayed.

O Click Budget Funds to select a fund from the Budget Funds/Fiscal Years lookup.
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Simulation Nam&m : Sirmulation Dumpban.l 1% ALL ETAFF CURRENT RATE

|E

FUND/ASCAL YEAR EXCLUSIONS LOCAL AMNUAL

SIMULATION OPTIONS FIRST PAY DATE CODES HOURLY/DAILY EXTRA DUTY MIDPOINT DEDUCTIONS

Samulation Mame 1% ALL  Desoiplion:1% ALL STAFF CURRENT RATE Ret - ] [

Delete FumdsiFiseal Years
4 1) p Adg

O Click +Add to add a row.

Fund/Fiscal Years|Type the fund code and the fiscal year. The fund code can be any digit between

101-999, and the fiscal year is a one-digit code that is the last digit in the fiscal
(school) year.

[ Click Save.

Local Annual

Select the local annual salary scales to be used in the simulation. The salary scales can default to

a particular percentage or amount increase with the ability to update individual pay
grade/schedule/steps.

Position Management > Utilities > Salary Simulation > Local Annual

This tab is used to automatically reference the correct annual salary for employees, based on their
pay grade, pay step, max days employed, and local schedule code. This table can be utilized to

alter simulations for those employees, such as teaching staff, whose pay is based on an annual
amount with step increases for years of service.

Set up local annual salary data:

Field Description
Simulation Name

Type the name of a simulation or click ¥ to select the simulation name
from a list.
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Field

Description

Simulation Description|Type 3 description of the current simulation or click ¥ to select the

simulation description from a list. The field can be a maximum of 30
characters.

O Under Records:

Simulation Name

Display only and indicates the simulation name as entered in the Simulation
Name field at the top of the page.

Description

Display only and indicates the simulation description as entered in the
Simulation Description field at the top of the page.

Pay Grade

Click ¥ to select the appropriate pay grade for the current simulation. This option
limits your selection.

Local Annual

Click to retrieve and select multiple pay grades from the annual salary table, or
create new entries to be included in the simulation phase.

O Click Retrieve. The local annual salary data is displayed.

O Under Modify, select either of the following criteria to modify local annual salaries:

e By Percent

e By Dollar Amt

O Under Salary:

maximum

Amount Type the dollar or percentage value to increase a salary. The dollar amount can be a

of six digits (e.g., 9999.99).

O Click Default to apply the amount entered in the Amount field to each salary.

Note: Only those

rows that have no value in the % Increase or Amount Increase columns are

affected when applying the default values.

O Click +Add to add a row.

Note: When adding a new row with +Add, the same pay grade, pay step, local schedule, and
maximum days employed must exist in the NYR Local Annual Salary Table, or the record cannot

be saved.

2026/05/26 02:02
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AT ey e 3 Shmulation Desciption! | o, || o FF CURRENT RATE JE
SIMULATION OFTIONS FIRST PAY DATE CODES FUND/ASCAL YEAR EXCLUSIONS LOCAL AMMLIAL HOURLY/DWAILY EXTRA DUTY MIDPOINT DEDUCTIONS
Simulation Marme: 1% ALL Description: 1% ALL STAFF CURRENT RATE @ 8y Percent tamount [ L0]%
(O By Dollar Amt
Delete Pay Grade  Pay Step Max Days Employed Local Sched Annual Amt % Increase Amount Increase Mew Amount .
[pom] [[2= ] (oo ] ] e |l oon] [ 0.00] AR
[ ] [ a ] [ 76 ] E 4897165 [ ._,;] [ o ] 48,97 1.65
[acr] [Co1 ] [ ] B | 0] | ann]
[ .__!_:] [ a2 ] [ ] :] 5086582 [ '_1:,'] [ 0. ] 50,865.82
[ .__.__!:.] [ 09 ] [ 207 ] :] 4897165 [ -_,:_;] [ 0 ] 48,971.65
[ .-_.|.;] [ 25 ] [ ] E 71,437.78 [ ._,._,3] [ 3_,_,31 71,437.78
[acr | [ 30 ] [226 | :] 7o7en1e [ oa] | 0.00] 70,762.18
(ve] (Lo ] (87 ) [ ] 0] aog| 4800060
[ NTE ] [ 1 ] [ Qa0 ] :] 46,200.00 [ _,:] [ o ] 46,200.00
[P.IL—] [ 10 ] [ 187 ] E 4895000 [ .__-_.,;] [ ;_:.'_\-;] 48,950000
[ NTE ] [ 14 ] [ 187 ] :] 4925000 [ .__:,:] [ L'.-'_"LZ] 449,250,00
[nie] [[12 ] [[(187 ] :] st | oa] | 0.00] 43,550.00
[.‘.II—.] [ 13 ] [ 187 ] :] 49.9500.00 [ _1.:_:] [ :_,3:] 49,950,00
[ NTE ] [ 14 ] [ 187 ] :] 50,450.00 [ -_,:_;] [ 0 ] 50,450.00
[r.lt] [ 15 ] [ 187 ] :] 51.250000 [ ..._.,;_;] [ :.Z.-'."J] 51,250000
(wel [ s 1 87 1 [ i | ool T .00l 5155000 B
aw]re(p] [Les] i
Pay Grade Type the code for the pay grade. The field can be a maximum of three characters.
Pay Step Type the code for the salary level within the indicated pay grade. The field can be
a maximum of two characters.
Max Days Type the maximum number of days worked at the indicated pay grade and pay
Employed step. The field can be a maximum of three characters.
Local Sched Type the optional, locally assigned, single-character code that is used to indicate
the separate pay schedules for professional and support staff with the same pay
grade, pay step, and maximum number of days employed.

The system populates the Annual Amt field with the annual salary for this pay grade and step from
the Local Annual NYR table.

Note: Each row can only be changed by a percent or dollar amount, not both, and if a row
previously had a value entered in the Amount Increase column, and now a value is entered in
the % Increase column, the Amount Increase column changes to zero.

% Increase Type the percentage of the increase.
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Amount Increase Type the dollar amount of the increase.
New Amount This field is calculated by the system.

O Click Refresh Totals to recalculate the new amounts when a new amount or percent is entered.

[ Click Save.

Hourly/Daily

Select the hourly/daily salary scales to be used in the simulation. The salary scales can default to
a particular percentage or amount increase with the ability to update individual pay grade/steps.

Position Management > Utilities > Salary Simulation > Hourly/Daily

This tab is used to automatically reference the correct hourly/daily salary for positions, based on
their pay grade, pay step, max days employed, and local schedule code. This table can then be
utilized to alter simulations for those positions, such as teachers, paraprofessionals, maintenance,
bus drivers, and other jobs as maintained by the district.

You must be logged on to a next year pay frequency to access this utility.

Set up hourly/daily salary data:

Field Description
Simulation Name Type the name of a simulation or click ¥ to select the simulation name
from a list.

Simulation Description|Type a description of the current simulation or click ¥ to select the
simulation description from a list. The field can be a maximum of 30
characters.

O Click Retrieve. The hourly/daily salary data is displayed.

O Under Records:

Field Description

Sim Name |Displays the simulation name as entered in the Simulation Name field at the top of the
page.

Descr This field is populated automatically with the simulation description as entered on the

Simulation Options tab.

Pay Grade|cjick { to select the appropriate pay grade for the current simulation. This option limits
your selection.

Note: In addition, you can click the Hourly/Daily button to retrieve and select multiple
pay grades from the hourly/daily table, or create new entries to be included in the
simulation phase.
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O Click Retrieve. The hourly/daily salary data is displayed.

O Under Modify, select either of the following criteria to modify hourly/daily salaries:

e By Percent
e By Dollar Amt

O Under Salary:

Amount|Type the dollar or percentage value to increase a salary. The dollar amount can be a

maximum of six digits (e.g., 9999.99).

O Click Default to apply the amount entered in the Amount field to each salary.

Note: Only those rows that have no value in the % Increase or Amount Increase columns are
affected when applying the default values.

O Click +Add to add a row.

§  Simulation Deser PBENT ) o AL STAFF CURRENT RATE B

SIMULATION OPTIONS ~ FIRST PAY DATE CODES  FUND/FISCAL YEAR EXCLUSIONS  LOCAL ANNUAL  HOURLY/DAILY ~ EXTRADUTY  MIDPOINT  DEDUCTIONS  UPDATE SALARY TABLES
Records Salary
Modify
Sim l| ALL Deser:1% ALL STAFF CURRENT RATE P— Amount: (i
|\1-,-(_-,1-_r[:]5 ’ T ] ’ it ] [ HaurlyfDaily ] O By Doliar Amt
[ ] [ez ] [ ] Dhaily 0.0 0.0 251,549 [ 0.00] | 00] 251.549 i
[ ] [ ] [ ] Daily 09 00 2B6.058 [ 0.00] | a0) IBEO5E
[z ] [ea ] [ ] Diaily 0.0 00 286957 [ 0.00] | 00] 286957
[ [ ) | ] Daily 00 00 236724 [ 0.00] | a0) 236724
[ ] [oes ] [ ] Diaily 0.0 00 251.450 [ 0.00] | 00] 251.450
=] [o ) | | Daily 00 00 312378 [ 0.00] | 0] 312376
[ ] [ez ] [ | Draily 0.0 o0 361.991 [ n.o0] | )| 361.991
[z ] [es ) [ ] Daily 00 00 305234 [ 0.00] | 0) 305234
[ ] [ ] [ ] Daily 0.0 0.0 321.220 [ no0] | ()| 321220
[z ] [es ] [ | Daily 00 00 349341 [ 0.00] | 00) 349,341
[ ] [oo ] [ I Daily 0.0 0.0 294.492 [ non] | 0.0] 294 492
[ ] [ ) [ ] Daily 00 00 301932 [ 0.00] | a0) 301932
[ ] [oz ] [ | Diaily 0.0 0.0 248800 [ noa] | 0.0] 248,800
(14 ] [ ] [ ] D i 00 299516 [ 0.00] | 9] 299516
[ ] [oea ] [ ] Daily 0.0 0.0 297.632 [ non] | 0] 297 632
[ ] [ ) [ ] Daily 00 00 380619 [ 0.00] | 9 360,61
‘ (7 (0] [Lewt) Refiesh Tosls (3) Add
Pay Grade |[Type the code for the pay grade. The field can be a maximum of three characters.
Pay Step Type the code for the salary level within the indicated pay grade. The field can be a
maximum of two characters.
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Rate Type [This field is populated by the system:

If the Hrs Per Day field is left blank, the rate type is set to the daily rate.
If the Hrs Per Day field contains hours, the rate type changes to hourly.

Pay Type Displays the type of pay for the selected simulation.

Hrs Per Day |Indicates how the rate is paid. If hours are not zero, the rate is considered an hourly
rate.

Local Sched |Type the optional, locally assigned, single-character code that is used to indicate the
separate pay schedules for professional and support staff with the same pay grade,
pay step, and maximum number of days employed.

Est Ovtm Hrs Displays the estimated annual number of overtime hours allowed for this pay grade
and step.

The system populates the Amount field with the hourly/daily salary amount authorized for this pay

grade and step

from the Hourly/Daily NYR table.

Note: Each row can only be changed by a percent or dollar amount, not both, and if a row
previously had a value entered in the Amount Increase column, and now a value is entered in
the % Increase column, the Amount Increase column changes to zero.

% Increase

Type the percentage of the increase.

Amount Increase Type the dollar amount of the increase.

New Amount

This field is calculated by the system.

O Click Refresh Totals to recalculate the new amounts when a new amount or percent is entered.

O Click Save.

Extra Duty

Include all extra duty codes in the simulation even if there is not an increase.

Position Management > Utilities > Salary Simulation > Extra Duty

This tab is used to automatically reference the correct extra duty salary for employees based on
their extra duty codes. This table can be utilized to alter simulations for those pay rates for part-
time functions required at each campus or LEA (e.g., Cheerleader Sponsor, and UIL events).

You must be

logged on to a next year pay frequency to access this utility.

Set up extra duty salary data:
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Field Description
Simulation Name Type the name of a simulation or click ¥ to select the simulation name
from a list.

Simulation Description|Type a description of the current simulation or click  to select the
simulation description from a list. The field can be a maximum of 30
characters.

O Under Records:

Sim Name |Displays the simulation name as entered in the Simulation Name field at the top of
the page.

Descr Displays the simulation description as entered in the Simulation Description field at
the top of the page.

Extra Duty |Type the appropriate extra duty code for the current simulation, or click  to select
Cd the extra duty code from a list.

O Click Retrieve. The extra duty code data is displayed.

O Click Extra Duty to select an extra duty code from the Extra Duty lookup. Or, create new entries to
be included in the simulation phase.

O Under Modify, select either of the following criteria to modify extra duty salaries:

e By Percent
e By Dollar Amt

[ Under Salary:

Amount Type the dollar or percentage value to increase a salary. The dollar amount can be a
maximum of six digits (e.g., 9999.99).

O Click Default to apply the amount entered in the Amount field to each salary.

Note: Only the rows without a value in the % Increase or Amount Increase columns are
affected when applying the default values.

4 Click +Add to add a row.
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- ETTEEm
1% ALL H

Simulation D&aipﬁan.l L% ALL STAFF

Cu

RRENT RATE

|-

SIMULATION OPTIONS FIRST PAY DATE CODES FUND/FAISCAL YEAR EXCLUSIONS LOCAL AMMUAL HOURLY/DAILY EXTRA DUTY MIDPOINT DEDUCTIONS UPDATE SALARY TABLES
Records Salary
Maodify
Sim Mame:1% ALL Descr-1% ALL STAFF CURRENT RATE B Amount
Extra Cuty CJ':] H [ tetrieve ] [ ] [ ra O ] @ By Dollar Amt
Delste ExtraDutyCd  Description Actount Code Activity Wholly Sep  Exp373  AcctType WICCode  inclSupplDock Rste  Amount % Increase Amt Incres
199-11-§112.00-001-324000 80 =] [E] G ] O 100000 | 0.00] [
199-11-5112.00-0 80 O = G 8 O 1200000 | oo [
199-11-6112.00-041-323000 80 O O <] ] O 100000 | 0.00] [
199-11-6112.00 80 O O G ] O 250000 | eog)
199-11-§112.00-101-311000 8O ] ] G 8 O 1500000 | 0.00] |
199-11-6112.00-101-321000 &0 [} [} B O 1000 | ooo] [
199-11-6112.00-101-323000 80 O O G B O 250000 | 0.00] [
199-11-6112.00-101-324000 80 O O 8 O 250000 | ooo] [
199-11-6112.00-101-325000 80 O [} G ] (] 50000 | 0.00] [
199-11-611800-001-311000 80 O O & ] O a0 [ 000 [
199-11-6118.00-041-423000 B0 O [E] 5 ] O aoo [ 0.00] [
199-11-6118.00-041-825000 79 O 5 B O 100000 ooo) [
199-11-611800-101-423000 80 O O 5 ] O aoo [ o.o0] [
199-11-6118.00-101-325000 80 O O 5 B O a0 [ ooo] [ i
— — — — - v
3
‘ a[»] [Lam] Rofrosh Totals  (3) Add

Extra Duty Cd

Type the extra duty code. The field can be a maximum of two characters.

Description

Type the name that best describes the code. The field can be a maximum of 16
characters.

Account Code

An edit mask allows you to type the full 20-digit account number, mask the
organization code, or mask the whole account number. If the organization code is
masked, when extra duty is assigned to the employee, the organization code
from the employee record would complete the code. If the entire code is masked,
when extra duty is assigned to the employee, a complete account code must be
entered on the distribution record for the employee.

Activity Click ¥ to select a PEIMS activity code and corresponding description.

Wholly Sep Click ™ to select whether the extra duty salary is subject to the Above State
Minimum Salary Calculations of the TRS 373 Report.

Exp 373 Click ™ to select whether the amount is to be distributed for the above state
base.

Acct Type Click ™ to select an account type that best identifies the type of salary. The
Acct Type field is a required field and must be populated to save entries in the
table.

w/C Cd

Click ™ to select the workers' compensation code.

Incl Suppl Dock
Rate

Display only and indicates if the supplemental extra duty amount is included in
the simulation or not.

The Amount field is populated with the salary amount authorized for this extra duty assignment from
the next year extra duty table.
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Note: Each row can only be changed by a percent or dollar amount, not both, and if a row

previously had a

value entered in the Amount Increase column, and a value is entered in the %

Increase column, the Amount Increase column changes to zero.

% Increase

Type the percentage of the increase.

Amount Increase Type the dollar amount of the increase.

New Amount

This field is calculated by the system.

Suppl Extra Days|If the extra duty will be used for extra days that the employee works, type the

number of additional days to be used for the simulation.

If this field is updated, the amount for any extra days worked is calculated. And, if
the supplemental position is tied to the employee's regular position, the amount
is calculated based on the daily rate of the regular position.

O Click Refresh Totals to recalculate the new amounts when a new amount or percent is entered.

O Click Save.

Midpoint

The LEA has the option to increase the minimum, midpoint, and maximum and/or increase the

employee’s pay.

Position Management > Utilities > Salary Simulation > Midpoint

This tab is used to manage the pay rates for hourly, noncontract employees, and contract
employees not covered under the Annual or Hourly/Daily salary tables.

Midpoint Salary Schedule

Set up midpoint salary data:

Field

Description

Simulation Name

Type the name of a simulation or click ¥ to select the simulation name
from a list.

Simulation Description

Type a description of the current simulation or click ¥ to select the
simulation description from a list. The field can be a maximum of 30
characters.

O Under Records:
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Sim Name |Display only and indicates the simulation name as entered in the Simulation Name
field at the top of the page.

Descr Display only and indicates the simulation description as entered in the Simulation
Description field at the top of the page.

Pay Grade cjick  to select the appropriate pay grade for the current simulation. This option will
limit your selection.

Note: In addition, you can click the Midpoint button to retrieve and select multiple pay
grades from the midpoint table, or create new entries to be included in the simulation
phase.

O Click Midpoint to retrieve and select multiple pay grades from the midpoint table, or create new
entries to be included in the simulation phase.

O Click Retrieve. The midpoint salary data is displayed.
O Under Modify, select either of the following criteria to modify midpoint salaries:

¢ By Percent
e By Dollar Amt

O Under Salary:

Minimum Type the percentage or dollar amount each row will increase by.
Maximum Type the percentage or dollar amount each row will increase by.
Midpoint Type the percentage or dollar amount each row will increase by.

Max Pct Pay Inc |Type the maximum percentage allowable for the simulation.
Midpt Pct Pay Inc|Type the maximum midpoint percentage allowable for the simulation.

O Click Default to apply the amounts entered in the Minimum, Maximum, and Midpoint fields to
each row.

Note: Only those rows that have no value in the % Increase or Amt Increase columns are
affected when applying the default values.

O Click +Add to add a row.
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SIMULATION OPTIONS FIRST PAY DATE CODES FUND/FSCAL YEAR EXCLUSIONS LOCAL ANNUAL HOURLY/DAILY EXTRA DUTY MIDPOINT DEDUCTIONS UPDATE SALARY TABLES DELETE SIMULATIONS

Records Salary
Modify
Sim Mame:1% ALL  Descr-1% ALL STAFF CURRENT RATE Minirmm: Maximusm: Midpoint:
(O By Percent
Pay Grade i s
. s B [ Retiieve ] [ Print ] [ Midgeint ] (® BvDousram | MaxPetPayinc[ggg) e Mident Pt Pay Inc[1ag) g [ T ]
Delete  Pay Grade Pay Type Hours  Dock Rate Type  Minimum % Increase Amt Increase New Min  Maximum % Increase Amt Increase Mew M
| | [ v oo 0000 [ oo [ 0.000] 0.000 0000 [ 0.00] [ 0.000] 0.0
1 3

- D *
NemeT o aLL H {19 ALL STAFF CURRENT RATE JH

SIMULATION OPTIONS FIRST PAY DATE CODES FUND/FISCAL YEAR EXCLUSIONS LOCAL ANMUAL HOURLY/DAILY EXTRA DUTY MIDPOINT DEDUCTIONS UPDATE SALARY TABLES DELETE SIMULATIONS

Records Salary
Madify
ALL STAFF CURRENT RATE Iinirmamc Maximurm; Midpont:
O By Percent = = —
Pay L====:] i [ Retrieve ] [ Print ] [ Midpoint ] ® &y Dollar At Max Pt Pay |..L 5 Midpnt Pot Pay ..L. %
n % Increase Amt Increase Mew Max  Midpoint % Increase Amt Incresse Mew Midpaint Max Pet Pay Inc Midpnt Pet Pay Ine Max Ine/Dec Amt  Midpnt Inc/Dec Amt
| o.00] | 0.000] 0.000 0.000 [ v.00) |[ 0.000] 0000 [ o.0a)| [ 0.00] 0.000 0.000
4 3

Pay Grade|(Type the locally assigned, three-character code for the pay grade.

Pay Type |Click ¥ to select a of pay type code.
Hours Type the number of hours authorized for this pay grade.

When pay types 1, 2, and 4 are calculated as daily rates, the Hours field is left blank.

When pay type 3 is calculated on an hourly pay rate, the Hours field requires a value.

The system populates the Minimum field with the lowest pay rate for this pay grade/pay type from
the Midpoint NYR table.

Note: Each row can only be changed by a percent or dollar amount, not both, and if a row
previously had a value entered in the Amount Increase column, and now a value is entered in
the % Increase column, the Amount Increase column will change to zero.

% Increase |[Type the percentage of the increase.
Amt Increase Type the dollar amount of the increase.
New Min This field is calculated by the system.

The system populates the Maximum field with the highest pay rate for this pay grade/pay type from
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the Midpoint NYR table.

% Increase |Type the percentage of the increase.
Amt Increase|(Type the dollar amount of the increase.
New Max This field is calculated by the system.

The system populates the Midpoint field with the calculated midpoint pay rate for this pay grade/pay
type from the Midpoint NYR table.

% Increase Type the percentage of the increase.
Amt Increase Type the dollar amount of the increase.
New Midpoint This field is calculated by the system.

Max Pct Pay Inc Type the maximum percentage allowable for the simulation.

Midpt Pct Pay Inc |Type the maximum midpoint percentage allowable for the simulation.
Max Inc/Dec Amt  |This field is calculated by the system.

Midpnt Inc/Dec Amt|This field is calculated by the system.

O Click Refresh Totals to recalculate the new amounts when a new amount or percent is entered.

[ Click Save.

Deductions

Designate the estimated employee and employer annual amounts for deductions. Vacant
positions can be included.

Position Management > Utilities > Salary Simulation > Deductions

This tab is used to designate estimated employee and employer annual amounts for deductions.
PMIS does not use the next year Staff Job/Pay Data; therefore, employee deductions are not
available for budgeting. Vacant positions can also be included in the simulation.

The intent of the employee amount is to have an annual estimated value of deductions that are
subject to a Cafeteria Plan 125 that affects FICA/Medicare tax calculations for budgeting purposes.
The employer amount is intended for those deductions where employer contribution needs to be
budgeted. The simulation looks at the current year payroll to detect which employees have that
deduction code, and takes the amount reflected in the Emp Amt field on this tab and reduces the
employee annual gross on the simulation by that amount for those employees who occupy
positions in the next year PMIS to determine the amount of FICA/Medicare that needs to be
calculated for Budget. This field is optional; however, leaving it blank will over budget for FICA and
Medicare, which may be preferred by some LEAs.

You must be logged on to a next year pay frequency to access this utility.

2026/05/26 02:02 21 ASCENDER - Position Management: Salary Simulations Overview



Business

Designate or add a deduction code:

Field Description

Simulation Name Type the name of a simulation or click ¥ to select the simulation name
from a list.

Simulation Description Type a description of the current simulation or click ¥ to select the
simulation description from a list. The field can be a maximum of 30
characters.

O Click Retrieve.

Simulation Name|Display only and indicates the simulation name as entered in the Simulation
Name field at the top of the page.

Description Display only and indicates the simulation description as entered in the
Simulation Description field at the top of the page.

O Click Deductions to select a fund from the Deductions lookup.

4 Click +Add to add a row.

Simulation Name{ .|  Simulation Desciption 15 | crarr cummenT RATE Ik

SIMULATION OFTIONS FIRST PAY DATE CODES FUND/FISCAL YEAR EXCLUSIONS LOCAL ANNUAL HOURLY/DAILY EXTRA DUTY MIDPOINT DEDUCTIONS UPDATE SALARY TABLES DELETE SIMULATIONS|

Simulation Name:1% ALL Description:1% ALL STAFF CURRENT RATE [

Retrieve ] [ it ] [ Deductions

Delete Deduction Code  Type Long Description Emp Amt Emplr Amt TEA Hith Ins Amt  Apply to Vacant Positions =
VH  ADDITIONAL WITHHOLDING Tax [ ooo] [ noo] [ 0.00] O
M1 ELECTRICITY COST [ ooo] | oo] [ 0.00] O
003 ML  MAROON & GREY SCHOLARSHIP [ ooo] [ o0] [ 0.00] Od
€U FIRSTMARK CREDIT UNION [ ooo] [ oo] [ 0.00] O
TSTA DUES [ ooo] [ oo] [ 0.00] O
UD  ATPE DUES [ o] [ oa] [ 0.00] =]
11 CHILD CARE [ o] o] [ 0.00) O
G [ o.o0] [ o.00] [ 0.00] d
11 [ ooo] [ oo0] [ 0.00] O
M1 [ ooo] [ 000] [ 0.00] O
- —D | D — 0
M1 [ ooo] [ ooo] [ a.0a] O
013 [ ooo] [ noo] [ 0.00] O
1 Mas [ o.00] [ 0.00] [ 0.00] O
[o5 ) L CINCINNATI LIFE INS. CO. [ ooo] [ oo0] [ 0.00] O -
‘ 5 (2] (Loa] Lo

Deduction Code |Type a three-digit code identifying the deduction. This code must exist in the
Deduction Code table.

Type Indicates the two-character code identifying the deduction and is automatically
populated based the Deduction Code field.

Long Description |Indicates the long name that best describes the deduction code and is
automatically populated based on the Deduction Code field.

Emp Amt Type the annual amount of the contribution by the employee with that
deduction.
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Emplr Amt Type the annual amount of the contribution by the LEA for the employee with
that deduction.

Apply to Vacant |Select to apply the employer amount to vacant positions included in the
Position simulation.

Note: If your TRS Active-Care is split between more than one payroll deduction
code, only select this field for one of the deduction codes. For example, if you
have four TRS Active-Care codes and each one has an annual amount of $2700
for the employer contribution and you select this field for all four codes, then
each vacant position in your reports will reflect a budget amount of $10,800 for
health insurance.

[ Click Save.

Update Salary Tables

Select the simulation records to update the next year salary data. Update all simulations in the
next year tables at one time. Once the update process is completed, the process is disabled until
the Copy CYR Tables to NYR Tables process is completed again.

Position Management > Utilities > Salary Simulation > Update Salary Tables

This tab is used to select the simulation records to update the next year salary data. All simulations
that will be updated in the next year tables need to be updated at one time. Once the update
process has been completed, the process is disabled until the Copy CYR Tables to NYR Tables
process is completed again.

It is your responsibility to ensure the simulation has not been updated multiple times, causing the
salary tables to be incorrect. It is also important to maintain the integrity of the simulation tables to
prevent duplicated steps.

You must be logged on to a next year pay frequency to access this utility.

Update existing salary tables:

O All available simulations are displayed on the left side of the page. Use the arrow buttons to select
the simulations to be updated.
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SIMULATION OPTIONS FIRST PAY DATE CODES FUND/FISCAL YEAR EXCLUSIONS LOCAL ANMUAL HOURLY/DAILY EXTRA DUTY MIDPOINT DEDUCTIONS UPDATE SALARY TABLES DELETE SIMULATIONS

Select  Simulation Mame Simulstion Deser User ID Select  Simulation Name Simulatien Deser User ID
\TE

1% TEST [ 1% .ALL 1% ALL STAFF
CURRENT RATE

12M0 12 MONTH STAFF FOR

wife

Y Y o o o O R

O Click Execute.

If any errors are encountered during the process, an error report is displayed. A listing of all
duplicates and rows in the simulation that are not listed in the salary table is displayed. All simulation
update processes are disabled until you clear the errors.

Review the report.
O Click Continue.
O Click Cancel to close the report and return to the Update Salary Tables tab.

If no errors are encountered during the process or you clicked Continue from the error report, a
report for each of the four salary tables is generated.

O Click Cancel to return to the Update Salary Tables tab without updating.
O Click Process to process the update. You are prompted to create a backup.

After the export process is completed, the actual update is performed. If the update is successful,
a message is displayed indicating that the simulation update was processed successfully.

Delete Simulations

Delete PMIS salary simulation records.

Position Management > Utilities > Salary Simulation > Delete Simulations
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This tab is used to delete simulation tables. The Delete Simulations tab is not a required step in the
simulation process.

You must be logged on to a next year pay frequency to access this utility.

Prior to using this utility, create an export using the Position Management > Utilities > Export PMIS
Tables page.

SIMULATION OFTIONS FIRST PAY DATE CODES FUND/FISCAL YEAR EXCLUSIONS LOCAL AMNUAL HOURLY/DAILY EXTRA DUTY MIDPOINT DEDUCTIONS UPDATE SALARY TABLES DELETE SIMULATIONS

1% TEST O 1% ALL 1% ALL
CURRENT RATE

Select  Simulation Name Sirmulation Deser User ID Select  Simulation Name Simulation Deser User ID
% TE STAF \FF

11 MO 11 MONTH

12 MONTH STAFF FOR

uife

e o o A e o A o |

Delete existing simulation tables:

O All available simulations are displayed on the left side of the page. Use the arrow buttons to select
the simulations to be updated.

O Select the simulations to be deleted.

O Click Execute to delete the selected simulation(s).

Position Management - Salary Simulation Reports

The following Calculation Reports are available. Regular and supplement positions are listed
separately for each employee.

Sample reports:
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Forecast Simulation Errors - The error report provides a list of encountered errors.

Dt Run: Forecast Samulation Errors

Cnty Dist: 150 Page:1 of 1

Simulation Name: 1%

Samulation Descr: 1% ACROSS THE BOARD

Position Nbr Billet Niv  Pos Typ  Ermor Message

PEADIRECTOR 00001 P State Minimum Salary is zero for TRS Position Code 01, State Minimum Days 0, State Step

PEADIRECTOR 00002 State Minimum Salary is zero for TRS Position Code 01, State Minimum Days 0, State Step

PEADIRECTOR 00003 State Minimum Salary is sero for TRS Position Code 017, State Minimum Days 0, State Step

PEADIRECTOR 00004 State Minimum Salary is zero for TRS Position Code 01, State Minimum Days (. State Step

PSADIRECTOR 00005 Position has TRS 373 amounts calculated but no distnbution accounts selected for expense 373

PEADIRECTOR 00005 State Maramwm Salary is zero for TRS Posibion Code 01, State Minimum Days 0, State Step 01

PEADIRECTOR 00005 Warning - calculated medpoint pay rate exceeds simulstion masamum for selecied pay grade

PEADIRECTOR 0000 State Manimum Salary is 2ero for TRS Position Code 01, State Mimmum Days 0. State Step
Procass complate

- - B - e B - R < S -}

End of Report

Forecast Simulation Calculations Position/Distribution - This report is similar to the Next Year
Payroll Employee Distribution report that is generated on the Payroll > Next Year > Interface NY
Payroll to NY Budget page, HRS9960 - NY Payroll Extract Distribution by Name. The report provides
the position, billet, and employee name.

Diater Fuanc Forecas! Semulabion Calcidatons PossionDistribabon
Crity Diest: ISD Page: 1of 7
Sarmuibation I'lame - Desor:
Fr Pos Hibe Billet  Posstion Description TEA TRS On
Account Code Typ WIC 373 G PA%  Amount FICA  Medcae Isuance Coilib  wWhComp  Behall  Linemp TRS TRSCae  DepCare
ot (=3 T [P .;..E:|.12. [ S R - I O Y - T - I S (R~ I - } - G148 -4)
A FHSA 1 Def Comp | Emple Mis<
B i [ 1 - -
F PALEILIARY 00500 [MRECTOR Pos Ty P Suppl Typ: Fust Paydate Cd: )12 Cal Cd: 12 PayConcptt M IncElg: ¥
Occ Emp: 000228 - FOUNTAIN, ELVWANDA K Campus: 53 FICAMedcare: M TRSSE 1 Unemp: ¥ PotDayEmgld 10000 PatofYr 10000 7% HeDay: 000
Job CdfExtra Duty Cdt 4200 - DIRECTOR PayTypl  PayGedfStp Sched:  4XE Nbr Doys Empld: 2510 Max Days: 25110 Days O 0.0
Salary At 3225100 HrbaDly Rale: 155 725 St St 5t Min Salary: 0.00 St Min Darya: 226
199-51612900-399-839000 G C M 1.000 39.353.00 00 70.62 00 00 170005 306953 00 53030 216.44
0o 00 0}
Cafe Amt: .00 4490964 Position Totals: ~ 39.353.00 00 57062 i) 00 170005 306353 L] 580,30 21644 0o
00 .00 o0
F PALEILIARY 00501 CUSTODIAN Pos Typ: P Suppl Type First Paydste Cd: )12 CalCek 12 PayConcptt M I Elg: Y
Ooc Emp: 000732 - TINNEY, T THOMAS Campus:534  FICAMedicare: M TRSSt 1 Unemp: ¥ PctDayEmgld: 10000 PoofYr 10000% HebDey: 0.00
Job CdExtra Duty Cd: 5000 - CLISTODIAN Pay Typd  Pay GediStp /Sched: 4201 Hbe Doys Ermpbd: 2510 Max Days: 2510 Days Of: 0.0
Salary At 1501700 Hehd Dy Rlate: 75765 St Stp St Min Salary: 0.00 St Min Diarys: .
199-014512900-293850000 G C M 1.000 20700 oo FL 00 00 &5 4 0 28526 a2 a
o0 (1] 00
Cafe Amt: .00 21,702 20 Plossiticn Totalks: 19,017.00 00 7575 i ] 00 8215 148333 o0 28526 10455 00
00 .00 i1}
F PALILIARY 00502 CUSTODAN Poa Typ: F Suppl Typc First Paydate Cd: 12 CalCd: 12 PayConcpt M InyBlig: Y
Occ Emp: 00020 - TERRY, STEVEN REMNEA Campus: 524 FICAMedcane: M TRSSE 1 Unemgp: Y Pot Day Empld- 10000 PeofYr 10000% HmDay: 000
Job CdfEtra Duty Cd 5000 - CLISTODIAN Pay Typl  Pay GedfStp Sched: 227/ |/ Hibe Days Emphd: 2510 MaxDaya: 2510 Diays O 0.0
Salary Ak 1866700 HebyfDly Raber 74 371 StSty St Man Salary 0.00 St Min Darys: 2%
199-51612900-953-859000 G C M 1.000 1865700 0o 27067 00 1] 80641 145603 00 230 w02 ey 0
o {11] 00
Cafe Amt: .00 2130278 Positicn Totabs: 18667.00 00 Zme7 0o 0 e41 145602 oo 280.0 ey .00
00 .00 00
F PAUMILLARY 00503 CUSTODLAN Pos Typ: P Suppl Typ: Fast Paydate Cd: )12 CalCd 12 PayComcpt M InaEhg: 7
Occ Emp: 000626 - ROBERTS. RENEE DANIEL Campus: 534 FICAMedcare: M TRSSt 1 Uremp: ¥ PdDayEmgld: 10000 Pdofyr 100007 HeMay: 000
Job CdfExtra Duty Cd 5000 - CLISTODIAN Pay Typl  Pay GediStp [Sched:  AX3 bibr Days Empld. 2510 Max Days: 25110 Days O 0.0
Salary At 2533400 HebyDly Radec 105,114 St St St Man Salary: Q.00 St Mn Days: 1%
199-51612900-299-899000 G C M 1.000 26.324.00 0o 257 00 00 113278 20579 00 35 TE HEN
00 (1i] 00
Cafe At 00 30,109.42 Position Totals:  26,384.00 00 38257 00 00 1138978 205795 00 39576 511 00

Current/Forecast Simulation Comparison Report - This report is similar to the HRS6650 -
CYR/NYR Salary Comparison Report in the next year payroll files. The report compares the current
year PMIS salary to the calculated salary in the simulation for the next year PMIS. The only difference
between this report and the HRS6650 report is that the HRS6650 report compares the employee's
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current year payroll salary to the employee's next year payroll salary.

Date Run: Current/Forecast Simulation Comparison Report

Cnty Dist ISD Page: 1 of 4

Simulation Hame - Descr:

Campus 1D:

s 2 A Pay Pay Pay Hriy/Dly
Posibon Nbr Billet Posibon Desconption Emp Hbr Employee lame Concpt Grd Stp Sched Rate Sal Amount

PAUXILIARY 00800 DIRECTOR 000519  NEVIL, MELINDA LYNM M AXE 140536 26,140.00 Cur
DIRECTOR 000519  NEVIL. MELINDA LYNN M AXE 143 347 26,663 00 Frest

PAUXILIARY 0001 000028 BULL BRYANE M AX3 110.937 20.190.53 Curr
FOOD SERVICE 000028 BULL BRYANE M A3 113.156 20,594 00 Frcst
MANAGER

PAUXILIARY 00602 000548  NOWAK. MONICA LEE ANN M AX3 93.200 10,345 20 Cuwr
FOOD SERVICE 000548  NOWAK, MOMNICA LEE ANM M AX3 95.064 17.302.00 Frost
MANAGER

PAUXILIARY 00603 000521 NEW EMPLOYEE, MELISSAD M AX3 100.320 18.258 24 Cumr
FOOD SERVICE 000521 NEW EMPLOYEE. MELISSAD M AX3 102.326 18.623.00 Frest
MANAGER

PAUXILIARY 00606 FOOD SERVICE 000772  WATSON. TRACY LYNN M A1 71.440 13.002 08 Cumr
\WORKER
FOOD SERVICE 000772  WATSON, TRACY LYNN M Aax1 72.869 13.262.00 Frest
\WORKER

PAUXILIARY 00607 FOOD SERVICE 000640 RUSSELL ROBERT MARIE M Al 80.758 14,698.00 Cuar
\WORKER
FOOD SERVICE 000840 RUSSELL ROBERT MARIE M Ax1 82373 14.992 .00 Frest
WORKER

PAUXILIARY 00608 FOOD SERVICE Vacant M A1 81.960 1491672 Cur
\WORKER
FOQD SERVICE 000773  WAYSON, TRAVIS L M A1 73522 13,381.00 Frest
\WORKER

PAUXILIARY 00611 FOOD SERVICE 000643 SAGER. ROBERT M Aax1 70.720 £,859.84 Cumwr
\WORKER
FOOD SERVICE 000643  SAGER. ROBERT M A1 77.030 14.019.00 Frest
\WORKER

Campus Totals:  Current 12441061
Forecast 138,836.00

Employee Base Pay Information Report - This report is unique to PMIS for budgeting purposes.
The report provides the base salary (no benefits) by pay grade. LEAs can review this information to
determine the cost of a base salary amount for a particular pay grade for the listed employees. The
forecast amount is the amount reflected on the position in the next year PMIS, the simulation amount
reflects the salary amount with the applied increase.
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Date Run: Employee Base Pay Information Report
Cnty Dist IsD Page: 1 of
3 o Pay Pay Fay Days Frest Sim Amt Iner %inc  Ing
Position Nir Billet  Position Descripion Camp Grd Stp Sched FIg Max! Rate / Rate / Rate / Rate/ g
P10ITEACHER 00201 2MD 101 TBA 00 1.00 187.000 186.631 186,631 0.000 0.00% M
000806 WRIGHT, ZEB LURAI 100.00 % 100.00 % 187.000 34,900.00 34,900.00 0.00 0.00%
Pay Grade | Step | Schedule Totals: Forecast 34.900.00
Simulabion 34,900.00
Salary Increase 0.00 0.007%
PIMTEACHER 00076 KINDERGARTEN 101 TBA 01 100 187.000 186631 192.246 5615 % vy
000592 POTEET, PENELOPE LYNN 100.00 % 100.00°% 187.000 34 90000 35.950.00 1.050.00 inz
Pay Grade | Step | Schedule Totals: Forecast 34,900.00
Simulation 35,950.00
Salary Increase 1.050.00 301%
P1IMTEACHER 00200 2ND 101 TBA 02 100 187.000 192.246 194 920 2674 139% ¥
000804  WRIGHT, WYOMING NICOLE 100.00 % 100.00 % 187.000 35.950.00 36.450.00 500.00 1.39%
P101TEACHER 00203 2MD 101 TBA 02 1.00 187.000 192,246 194.920 2674 1.39% v
000683  SOLES. SHANMNAN RENEE 100.00 % 10000 %  187.000 35.950.00 36.450.00 500.00 1.39%
P101TEACHER 00300 3RD 101 TBA 02 1.00 187.000 192 246 194 920 2674 139% ¥
000639 STACK SHARROM MICHELLE 100.00 % 100.00 % 187.000 35.950.00 36.450.00 500.00 1.39%
Pay Grade | Step | Schedule Totals: Forecast 107,850.00
Simulation 109.350.00
Salary Increase 1.500.00 1.39%
PI10ITEACHER 00021 EARLY ED 101 TBA 03 100 187.000 194 920 199.198 4278 219% ¥
000750  WALLIAMS, VIRGINIA RHEA 100.00 % 100.00 % 187.000 36450000 37.250.00 £00.00 2.19%
PAIMTEACHER 00102 15T 101 TBA 03 100 187.000 154 920 199.198 4278 219% ¥
000207  YOUNG, ZOE ANN 100.00 % 100.00 % 187.000 36.450.00 37.250.00 &00.00 2.19%
PIMTEACHER 00202 2MD 101 TBA 03 1.00 187.000 194520 199.198 4278 219% ¥
000765 WALKER, TORRI DAVID 100.00 % 100.00 % 187.000 36,450 00 37.250.00 £00.00 219%
PTEACHER 00209 ENGLISH 001 TBA 03 1.00 187.000 199.19¢ 199.198 0000 0.00% N
000823 STEPHENS. ASHLEY 100.00 % 100,00 % 187.000 37.250.00 37.250.00 0.00 0.00%
Pay Grade /| Step / Schedule Totals: Forecast 146.,600.00
Simulation 149,000.00
Salary Increase 2.400.00 1647%

Forecasting Report - This report is unique to PMIS for budgeting purposes. The report provides the

base salary without benefits.
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Date Run: Forecasting Report
Cnty Dist: 15D Page: 1of 3
Simulation lName - Descr:
Pos Pos Pay Pay Pay Pay Max Midpnt Pclof Incr  HyDly Hrs Per  Nbr Days Salary Pet Day
Pos Nbr Billet Typ Stat Cpt Grd Stp Sched Days Base Midpnt Eg Rate Day Empid At Empid
Freq Emplbr Emp Hame Pet of ¥r FTE
PI0ITEACHER 00020 P A A TBA 19 187.0 Y 269519 0.00 187.0 50,400.00 100.00 %
F 000034 BAULOS, ANGELA A 100.00 % 1.00
FI0ITEACHER 00021 P A A TBA 03 187.0 Y 199158 0.00 1870 3725000 100.00 %
F 000730  WILLIAMS, VIRGINIA RHEA 100.00 % 1.00
PI10TTEACHER 00050 P A A TBA 14 187.0 Y 246524 0.00 187.0 46,100.00 100.00 %
F 000060 BOURLAND, BILLIE 100.00 % 1.00
PIDITEACHER 00075 P A A TBA 12 187.0 Y 23770 0.00 1870 44 45000 100.00 %
F 000419 LEE. KELLI CAWENS 100.00 % 1.00
PIITEACHER 00078 P A A TBA DN 187.0 Y 192246 0.00 187.0 3595000 100.00%
F 000552 POTEET, PENELOPE LYNN 100.00 % 1.00
PIOITEACHER 00077 P A A TBA 26 1870 Y 289572 0.00 187.0 54.150.00 100.00 %
F 000102 CAMP, CARRIE 100.00 % 1.00
PIOITEACHER 00078 P A A TBA 17 187.0 Y 260963 0.00 187.0 48.800.00 10000 %
F 000330 HOWARD. JENNIFER OWENS 100.00 % 1.00
PIOITEACHER  D0079 P Vv A TBA 10 187.0 N 229144 0.00 00 4285000 100.00%
F Vacant 100.00 % 1.00
PIOITEACHER 00100 P A A TBA 12 187.0 Y 237701 0.00 187.0 44 45000 100.00 %
F 000747 UPTERGROVE, TERESA L 100.00 % 1.00
PIDITEACHER 00101 P A A TBA 09 187.0 Y 224 886 0.00 1870 4205000 100.00 %
F 000750 VAN RITE, TERRY 100.00 % 1.00
PIOITEACHER 00102 P A A TBA 03 187.0 Y 199158 0.00 1870 37.250.00 100,00 %
F 000807 YOUMNG. ZOE ANN 100.00 % 1.00
PI0ITEACHER 00103 P A A TBA 12 187.0 Y 237701 0.00 187.0 4445000 100.00 %
F 000624 RILEY. REGINA ELIZABETH 100.00 % 1.00
PI0TTEACHER 00200 P A A TBA 02 187.0 Y 194.920 0.00 1870 36.450.00 100.00 %
F 000804  WRIGHT, WYOMING NICOLE 100.00 % 1.00
PINMTEACHER 00201 P A A TBA D 187.0 N 186.631 0.00 187.0 3490000 100.00 %
F 000806  WRIGHT, ZEB LURAI 100.00 % 1.00
PIOTTEACHER 00202 P A A TBA 02 1870 Y 199.1%8 0.00 1870 37.250.00 100.00 %
F 000765  WALKER, TORRI DAVID 100.00 % 1.00
PIITEACHER 00203 P A A TBA 02 187.0 Y 194 920 000 1870 3645000 10000 %
F 000683  SOLES, SHANMAN REMEE 100.00 % 1.00

Forecast Account Distribution Journal by Salary Account - This report is unique to PMIS for
budgeting purposes. The report includes salary and benefits based on the simulation increases. LEAs
can view salary amounts by fund and function.

Date Runc Forecast Account Distribution Journal by Salary Account
Crty Dist 15D Page:4 of 6
Samulation Name - Descr:
Account C4 Aocthemoont  FICAMed EmgrConts WICAmt  TRSOn  Unemp  TRSAmts  Depend Care jes  TEAHIh
Employee bl lame Froq Campus  BI¥X 5141 6142 6143 Bohali-Gl44 6145 6145 6148 6149 E142

199-51-6129.00-595 k35000 Total: 23522300 341073 000 937253 1BMTAD 0.00 482210 0.00 0.00 0.00
198-51-6129.00-999 Tokal: 23520300 idmn 000 927253 1834740 0.00 4E2 10 0,00 0.00 0,00
199-51-6129.00 Totat 2522300 34107 000 927291 1834740 0.00 482210 0.00 0.00 0.00
193515129 51-995- 95000

000311 - HICKS JR, JANET L - 36.303.00 5263 000 156829 263163 0.00 744 22 0.00 0.00 0.00

000445- LUTTRELL LACEYSTEVEN F %55 30.346.00 44002 000 131055 23869 0.00 62213 0.00 0.00 0.00

QUOS-NEWEMPLOYEE MICHAEL  F 995 3227200 45794 000 133415 25172 0.00 66158 0,00 000 0.00

000563- PARMAN, MICHOLEMOORE  F 995 37.102.00 53798 000 160281 2693% 0100 760,59 000 000 0.00

000538 - GUY. PHYLLIS & Foow5 3232300 45568 000 139635 252119 000 662 63 000 000 0.00
156-51-6129.51- 556859000 Tetal: 1EBMED0 244100 000 TIRE 131309 0.00 345111 0.00 0.00 0.00
199-51-6129 51995 M9000 Total 1BBMEN0 244100 000 72725 13109 0.00 34511 0.00 0.00 0.00
199-51-6129.51-599 Total 1BBME00 244100 000 TIRE 13130W 0.00 345111 0.00 0.00 0.00
19851612951 Total: 168,345 00 24410 000 727255 1313099 0,00 345 0,00 0.00 0,00
199-51-6129 Total 40356900 585174 000 1654548 214783 0.00 B2zl 0.00 0.00 0.00
19951 Totak 403563.00 58517 000 1654548 314783 0.00 827321 0.00 0.00 0.00
19 Total 187594200 2720197 000 BMABSH 13855718 000 4532761 0.00 0.00 0.00
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Forecast Account Distribution Journal of All Expenditures - This report is similar to the Next
Year Payroll Account Distribution report that is generated on the Payroll > Next Year > Interface NY
Payroll to NY Budget page, HRS9970 - NY Payroll Extract Distribution by Acct. The report provides the
account code with a list of employees with the distribution code, salary, and benefits.

Diate Run: Forecast Account Distribution Journal of All Expenditures

ICnity Dist: IsD Page: 8 of 13

[Simulation Hame - Descr:

Pay Pay Pay FTE
Account Cd Acty Cd Freq Employee Hbollame Campus Concpt Grd Sip Sched Acct Amount Units

159-51-6141.00-953-59%000 80 F 000428 - LENAMON. KEVIN L 994 AX1 283.14 0.00

193-51-6141.00-993-255000 80 F 000564 - PARSLEY, NICOLE 994 AX 283.29 0.00
MARLENE

193-51-6141.00-993-#95000 20 F ﬁ,’C-SEE - PLOWMAN, PATRICIA i) L1 283.30 0.00
MAY

153-51-6141.00-593-855000 80 F 000606 - RASCO, RANDAL G54 AX1 26547 0.00
ANDREW

153-51-6141.00-995-855000 80 F 000626 - ROBERTS. REMNEE 994 AX3 375.06 0.00
DANIEL

199-51-6141.00-993-855000 &0 F 000667 - SHERLEY, SALLY 994 A1 259.06 0.00
THOMAS FELIPE

195-51-6141.00-995-895000 80 F 000678 - SMITH, SARAH N 994 Ax1 26800 0.00

199-51-6141.00-995-F55000 80 F 000720 - TERRY, STEVEM RENEA 994 A1 265.36 0.00

153-51-6141.00-933-F55000 80 F 000732 - TINMEY, T THOMAS 954 AX] 270.34 0.00

199-51-6141.00-999- 1995000 Totak 341073 0.00

199-51-6141.00-599 Total: 341073 0.00

199-51-6141.00 Total: 341073 0.00

199-51-6141.51-993-899000 80 F 000311 - HICKS JR, JANET L 995 AX6 526.39 0.00

159-51-6141.51-995-859000 80 F gac-*-'-és - LUTTRELL LACEY 995 Axd 44002 0.00

TEVEN

199-51-6141.51-995-F55000 80 F 000534 - NEW EMPLOYEE, 995 AX4 46794 0.00
MICHAEL G

193-51-6141.51-993-835000 80 F 000563 - PARMAN, NICHOLE 95 A4 537.98 0.00

Budget Expenditure Report for Position Management - This report is similar to the Next Year
Payroll Account Distribution report that is generated on the Payroll > Next Year > Interface NY Payroll
to NY Budget page, HRS9970 - NY Payroll Extract Distribution by Acct. The report provides the
position names with the distribution code instead of providing the employee names with the
distribution code, salary, and benefits.
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Date Run: Budget Expenditure Report for Posibon Management
Crniy Dist: ISD Page: 10 of 1
Simulation Name - Descr:
FTE

Account Cd Position Description Acct Amount Unit=
240-356129
240-35-6129.00
240-35-6129.00-999-F39000 DIRECTOR 26.140.00 1.00
240-35-6129.00-999-F59000 FOOD SERVICE MANAGER 20.191.00 1.00
240-35-6129.00-999-F39000 FOOD SERVICE MANAGER 16.962.00 1.00
240-35-6129.00-933-F535000 FOOD SERVICE MANAGER 18.258.00 1.00
240-35-6129.00-995-F55000 FOOD SERVICE WORKER 13.002.00 1.00
240-35-6129.00-999-F39000 FCOD SERVICE WORKER 14.698.00 1.00
240-35-6129.00-999-F39000 FCOD SERVICE WORKER 13.119.00 1.00
240-35-46129.00-939-£59000 FOOD SERVICE WORKER 13.745.00 1.00
240-35-6129.00 Total: 136.115.00 2.00
240-35-6129 Total: 136.115.00 800
240-356141
240-35-6141.00
240-35-6141.00-995-755000 DIRECTOR 379.03 0.00
240-35-6141 00-939-+59000 FOOD SERVICE MANAGER 29277 0.00
240-35-6141.00-999-255000 FCOD SERVICE MANAGER 2451595 0.00
240-35-6141 00-939- 55000 FOOD SERVICE MANAGER 264 74 0.00
240-35-6141.00-939-255000 FOOD SERVICE WORKER 18853 0.00
240-35-6141 00-999-55000 FOOD SERVICE WORKER 21312 0.00
240-35-6141 00-939-255000 FOOD SERVICE WORKER 19023 0.oo
240-35-67141 00-939-55000 FOOD SERVICE WORKER 199.30 0.00
240-35-6141.00 Total: 1.97367 0.00
240-35-6141 Total: 1.97367 0.00
240-35-6143
240-35-6143 .00
240-35-6143 00-939-935000 DIRECTOR 33692 0.00
240-35-6143 00-939-435000 FOOD SERVICE MANAGER 87225 0.00
240-35-6143 00-939-435000 FCOD SERVICE MANAGER 73276 0.oo
240-35-6143 00-939-435000 FOOD SERVICE MANAGER 78875 0.00
240-35-6143 00-935-455000 FOOD SERVICE WORKER 561.69 0.00
240-35-6143 00-939-435000 FOOD SERVICE WORKER 63495 0.00

Forecast Positions with Budget Accounts, Amounts and Units - This report is unique to PMIS
for budgeting purposes. The report provides a snapshot of the employee and a list of distributions
indicating the LEA's cost of a position.
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Date Run: Forecast Positions wath Budget Accounts, Amounts and Units
Cnty Dist: IsD Page:2 of 12
Simulation MName - Descr:
Campaus 1D:
FTE
Position HNbr - Billet: Description Employee HNumber - Name Account Cd fcct Amount Units
PIOTTEACHER - 00020: EARLY ED 000034 - BAULOS, ANGELA A
199-11-6119.00-101-"23000 50,400.00 1.00
199-11-6141.00-101-"23000 730.80
193-11-6143.00-101-723000 45961
1953-11-6144.00-101-723000 386551
198-11-6146.00-101-723000 1.084.40
Position Total: 56.730.32 1.00
P101TEACHER -00021: EARLY ED 000790 - WILLIAMS, VIRGINIA RHEA
199-11-6119.00-101-823000 18.625.00 0.50
198-11-6119.00-107-430824 1362500 0.50
195-11-6141.00-101-823000 270.06
193-11-6141.00-101-%30824 270.07
199-11-6144.00-101-%23000 130414
193-11-6144.00-107-430824 1.304.14
153-11-6146.00-101-%23000 497 65
198-11-6146.00-101-%30824 497.65
Pesition Total: 4139331 1.00
PIITEACHER -00050: PRE-K 000060 - BOURLAND, BILLIE
198-11-6119.00-101-%32000 46.100.00 1.00
198-11-6141.00-101-432000 668.45
199-11-6143.00-101-%32000 594 18
198-11-6144.00-107-%32000 3,569.69
1553-11-6146.00-101-532000 965.40
Position Total: 51.897.72 1.00
PIOITEACHER - 00075: KINDERGARTEN 000419 - LEE, KELLI OWENS
199-11-6119.00-107-811000 44.450.00 1.00
199-11-6141.00-1071-%11000 54453
199-11-6143.00-107-K11000 57282
193-11-6144 00-1071-511000 343126
198-11-6146.00-107-211000 939.16
Pasition Total: 50,037 87 1.00

Forecast Simulation Update to Budget - This report is displayed when the Update Budget field
is set to I - Increase or add to the amounts in Budget under Update Options on the Position
Management > Utilities > Salary Simulation > Simulation Options tab.

Date Run: Forecast Simulation Update to Budget
Cnty Dist: ISD Page: 1 of 1
Simulabion Name - Descr: 1% - 1% ACROSS THE BOARD
Budget Update: Replace the amounts in Budget
Last Year This Year Thas Year Simulation Mead Year
199-41-6118.00-737-455000 EXTRA PAY PROFESSIONALS 0.00 9.000.00 9.000.00 125.543.00 125.543.00
199-41-6142.00-737-999000 GROUP HEALTH & LIFE 0.00 Qoo 0.00 1.500.00 1.500.00
INSURANCE
199-41-6144.00-737-43%3000 TR/CARE OMN BEHALF 0.00 0.00 0.00 15593443 15.934.00
PAYMENTS
199-41-6146.00-737-435000 TEACHER RETIREMENT 0.00 55.00 55.00 £.260.23 £.260.00
Fund Totals: 0.00 9.055.00 9.055.00 149,237 66 149.237.00
End of Report District Totals: 0.00 9,055.00 9,055.00 149,237 66 149.237.00
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